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1 Whatis OffRoad Test Anywhere Anytime®?

OffRoad is a tool to enable test execution and defect management while not connected to the Quality
Center server. All test runs executed in OffRoad, new defects and modified defects from Quality Center
project can be sent back to the originating project.

Testing is a complicated set of processes making the management of the testing, test results and whole
process very demanding. With the advantages of what OffRoad provides, it is possible to execute tests
without being tied up in a particular place or network connection.

Create

- requirements Test set is exported to
- test cases an file which can be
- test sets sent to other users.

Online test Download test set

Is local computer

Analyze |- [ from server to used for testing? No-»| Export test set
planning OffRoad 9!
A
Yes Send test set
v
Execute test cases
1 Upload results Can local - Create new runs
e from OffRoad to [« Yes computer connect >« - Create new defects < Import test set
the server o the server? - Add attachments
y - Manage results
_ No
Import received s
test set to be Export test set and
able to upload Import test set (¢ Send test set-——— Export test set send it to user
results. who has
— connection to the

server

Picture 1 Simplified OffRoad Usage

Create Test Set and Add Test Cases into it is a phase where user is planning what to test, when and by
whom.

Select Existing Test Set from Quality Center is where using OffRoad already existing Test Set is selected for
offline execution. All data needed from test case, test set, test case in test set and defect (including project
customizations) are downloaded to OffRoad.

Create Defects is when user is creating new defects using OffRoad which are first stored on the local
computer.

Modify Existing Defects is when together with other data user selected set of defects from Quality Center
to be downloaded as well and these defects are then modified using OffRoad.

Execute Runs for Test Cases is *basic* functionality in OffRoad, creating new runs using Manual Runner or
Fast Run functionalities. This includes viewing of steps and marking them passed/failed/NA/Not Completed.

Upload Results to Quality Center is a phase when all modifications done locally while not connected to the
Quality Center server are uploaded to the server. New defects are created, runs added and modified
defects are saved to Quality Center server.
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Analyze Testing Results is then again normal Quality Center functionality when all testing results are being
reviewed, analyzed and decisions being made on how to continue testing.
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2 OffRoad Installation

Installation of OffRoad is simply matter of executing OffRoadSetup.msi and following instructions on the
screen.

You will need administrative permissions on target computer when installing OffRoad.

Latest version of OffRoad is available in here: http://onroad.juvander.fi/Community/files/.

2.1 Before You begin Installation
OffRoad System Requirements are very basic, but verify these before starting the installation.

Quality Center Server:
OffRoad does not put any specific requirements towards Quality Center server.
Following versions are supported:

- Quality Center 9.2
- Quality Center 9.0
- Quality Center 8.2
- TestDirector 8.0

OffRoad Client Computer:

- Windows 2000/XP/Vista

- Microsoft .NET 2.0 Framework

- Internet Explorer (OffRoad uses mshtml component from Internet Explorer)

- OffRoad instance that is used to connect to Quality Center correct version of Quality Center client
components are needed.

- OffRoad which is used only via import/export functionality, Quality Center components are not
needed.

OffRoad setup does not include .NET 2.0 Framework, this can be downloaded from here:
http://www.microsoft.com/downloads/details.aspx?FamilylD=0856eacb-4362-4b0d-8edd-
aab15c5e04f5&DisplaylLang=en

2.2 Installing OffRoad
Please note that by default OffRoad cannot be executed from network drive, only from local drive. This is
default security setting in .NET runtime.

To install OffRoad, execute a file called OffRoadSetup.msi. This will launch setup wizard which will then
guide through the installation.

Select Next from here:
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ﬁ‘}l OffRoad Test Anywhere Anytime

Welcome to the OffRoad Test Anywhere Anytime
Setup Wizard

The ingtaller will quide you through the steps required to install DR oad Test Anywhere Angtime an
wour cormpter.

WARMIMG: Thiz computer pragran is pratected by copyright law and international treaties.
IInauthaorized duplication or distribution of this program, or ang partion af i, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent pozsible under the law,

L

Select ‘l Agree’ and Next:

ﬁ OffRoad Test Anywhere Anytime

License Agreement

Pleasze take a mament to read the licenze agreement now. If vau accept the terms below, click "l
Agree", then "Mext". Othenwize click '"Cancel”.

Offfoad - Offline Test Execution Tool
() Copyright 2005-2008 by Juvander Consulting Oy. All Rights Reserved

IMPORTARNT - READ CAREFULLY: This End User License Agreement
("EULA") is a legal agreement between YOL as Licensee and JUVANDER
COMNSULTING for the SOFTWARE PRODUCT identified above. By
installing, copying, or otherwise using the SOFTWARE FPRODUCT, YOU

anree tn he hnond b the tprmes nf this Fl If vert dn nnt anree tn the

(7| Do Mat Agree @ | Agree

SOFTWARE PRODUCT LICENCE AGREEMEMNT o

Cancel ] [ ¢ Back ] [ Mext »
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Here a place where you need to make a decision which version of Quality Center server you are going to

connect to.

If you don’t know which version of Quality Center server you are using, please contact your Quality

Center administrator for this information.

ﬁl OffRoad Test Anywhere Anytime

=)

Select your Quality Center Version

Cuality Center 8.2 includes support alzo for TestDirector 3.0

i@ Quality Center 9.x

(7 Quality Center 8.2

)

'ifgh_-@

e

-y

Select installation folder or accept default one. You can also install OffRoad only to you or for all users using

this computer.
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ﬁ‘}l OffRoad Test Anywhere Anytime

Select Installation Folder

The ingtaller will inztall DR oad Test Angwwhere Angtime to the following folder.

Toinztall in thiz folder, click "Mext”. Taoinztall ko a different folder, enter it below or click "Browse"',

Enlder:
C:AProgram Files [+861% wvander Conzulting 0w OFfRoad Test Arywhe [ Browsze... ]

[ Diisk Cost... ]

Install Off Road Test Amywhere Amytime for yoursef, ar for anyone who uses this computer:

@ Evemone

7 Just me

And finally select Next to start the installation process:

ﬁ OffRoad Test Anywhere Anytime

Confirm Installation

The ingtaller iz ready ta inztall DffRoad Test Anpwhere Anytine on vaur computer.

Click "Mest" to start the installation.
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ﬁl OffRoad Test Anywhere Anytime
Installing OffRoad Test Anywhere Anytime
QffFoad Test Anpwhere Anytime iz being installed.
Pleaze wai...
< Back MHext =

And once everything is done select Close to close the setup:

ﬁ OffRoad Test Anywhere Anytime

Installation Complete

OffRoad Test Anpwhere Anytime has been successfully installed.

Click "Cloze' to ext.

Pleaze uze Windows Update to check for any critical updates to the HET Framewaork.

Cancel < Back

e -y

This installation created two options to launch OffRoad:
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CHtRoad

1. From Desktop using desktop shortcut:
2. Through menu Start -> All Programs -> Juvander Consulting Oy -> OffRoad

2.3 Upgrading OffRoad
When installing newer version of OffRoad it will remove previous installation automatically before installing
new one.

Upgrade phases are the same as installing a fresh copy of OffRoad.

Please note that before upgrading OffRoad, all run results, new and modified defects should be uploaded
to the Quality Center project. Upgrade does not upgrade this data; it is left unmodified and can be used
with the current version if that is installed again.
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3 Uninstalling OffRoad

OffRoad is uninstalled from Control Panel -> Add Remove Programs (in XP) or Control Panel -> Programs
and Features (in Vista):

File Edit View Tools Help

Uninstall or change a program
installed updates

- To uninstall a program, select it from the list and then click "Uninstall”, "Change", or "Repair”.
nline at

' Organize » i= Views . &} Uninstall &4 Change &} Repair (7]

MName | Publisher Installed 1+ =
Turn Wi eatures on or ﬂ Microsoft Windows SDK for Visual Studic 2008 SD... Microsoft Corporation 2/1/2008
off 5 Microsoft Windows SDK for Visual Studio 2008 To.. Microsoft Carparation 2/1/2008
Install a p m frem the & MSDN Library for Visual Studio 2008 - ENU Microsoft 2/2/2008
n MEXML 4.0 SP2 (KB936181) Microsoft Corporation 12/20/200
BT ASYMI 4 0 SP? (KRAATRIT Mirrnenft Carnaration 125200200

© OffRoad Test Anywhere Anytime Juvander Consulting Oy

PGP Desktop

£ PowerDVD

@ QCExplorer

@ QCExplorer

(@) Quality Center Client Side HP

@ QuickSet Dell Inc.

Size: 225 MB

OffRoad Test Anywhere Anytime  Publisher: Juvander Consulting Oy
o Comments: OffRoad Installer

Picture 2 Uninstall Offroad in Windows Vista
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4 OffRoad Licensing

Juvander Consulting Oy offers different types of licenses for OffRoad:

1. Automatic Trial license, fully functional OffRoad for 14 days.
Manual Trial license. If above does not work, you can request trial license from here:
http://www.juvander.fi/LicenseRequestForm.aspx.

3. Seat Based Permanent license. License is installed and used by specified computer.
4. Floating License. License is shared among users, one user reserves license for X days at a time.

For licensing related question, contact us: http://www.juvander.fi/ContactUs.aspx.

4.1 Trial License
When starting OffRoad with a trial license, this dialog is shown first:

P

OffRoad lilﬁ

| already have a license

OffRoad

By Juvander Cansulting Chy

By continuing you agree to the tems Continue ] | Cancel

L o

After you select Continue, click Try to continue from here:
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This is a Trial [

OffRoad Test Anywhere
Anviime

By Juvander Consutting Cry

s]

| g
EIH E

By continuing the trizl you agres to be bound by the terms of the EULA accompanying this software.

14 day=s remaining. | have a license

After these steps you have a fully functional OffRoad for 14 days.
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5 Using OffRoad

5.1 OffRoad Main Window

OffRoad’s main window has few elements:

© OffRoad o
File  Edit Options Window  Help
Menu and Toolbar for
I Execute Run - (3 different actions
Test Set .4 0 Execution - 3

Switching
between views is
done by using
tabs in here

Local Test Sets | Test Set Requirementsl

This is the main
working area

Picture 3 OffRoad Main Window

Opening of local already downloaded test set is done from Local Test Sets tab by selecting it from the tree

and double clicking it.
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@ OffRoad

File Edit Opticns Window  Hel

Local Test Sets

Local Test Sets:

B qci2

=-[jJ DEFAULT
- [§ QualityCenter_Demo

= (‘3 Mercury Tours Web Site
EI ‘ﬁ Functionality And Ul

=} ‘ﬁ Performance And Lo:

E- {? Release 10.5
E| % Cycle 1

E| (‘3 Cycle 2
«[] Mew Features
- [£] Regression
E| '{*3 Cycle 3
..... D Sanity
B ¥ Cyoe 4

«[] Mew Features
- |£] Regression
D Sanity
B- {3 test

| T | 3

----- [&] Mercury Tours Fu

----- [Z] Mencury Tours Lc

|£] New Features —=

----- [Z] testset not to be foun

p
= Execute Run -~ &3

Execution

H

Local Test Set can be
selected from here

Local Test Sets }st Set| Requirementsl

To download new data from Quality Center server, see chapter Downloading of Requirements, Test Sets

and Defects.

Once Local Test Set has been opened, view changed into this:
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) OffRoad - Test Set: New Features Domain: DEFAULT Project: QualityCenter Demo

e Ot Window: [Help Currently selected entity's name

J-[E] Ml Defects (75)

i_ist of Test Cases
for Execution

All Runs found in

this Test Set All Defects found

in this Test Set

EFH (%} Execute Run ~ @
Test Set o 0 Test Set: New Features *
=B Test Set [Server hitp://qc92:8080/acbi - joct Qua
; hittp:/fgc92: ‘qcbin] [Domain:DEFALULT] [Project QualityCenter_Demo]
=-E [Download Time:5/24/2008 9:04:10]
ﬂ'- Defects (75) —
i =] Attachments (D) List of Defects N
&.? Test Cases (31) .
4[E] Al Runs () -

Close Date ;I Status
Test Set
Open Date I ;I
ITG Reguest Id
Downloaded User Defined Fields

Requirements are
found from here

Requirem...

From this view it is possible to find all defects, runs, test cases and requirements that are linked into this

local downloaded test set.

There are two special collection nodes in here: All Runs (See chapter All Runs) and All Defects (See chapter
All Defects). These contain all runs and defects that are found in this test set. All new runs and defects are

added into these.

Different toolbar options are these:
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N
“Remove Entity .rnain: DEFAULT Project: QualityCenter_Demo [ ==l g
Eile
S H & | [@ 08 | 5% ExecuteRun ~ &
e | T . Back to Test I 2 b
' G Ia.sas Node Stggﬁ eErJn Tester Exec Date T
== - Create new-run-for-- =] E : E nza =]
by i Passed || alice_|» | 5242008 9:33AM  :9
e selected test case - == o
L oad rewdl Select grid coluffins- | [=. 2 ind A js[1] :Passed E3 E3 10/21/2005 3:00 AM 1
oot EtA - 7| [| Departing Date[1] Failed [ [=] 872005 300 AM |1
Mo Run [+ | Returning Date[1] Failed || [ 9/1/2005 3:00 AM 1
Upload Results to No Run [« View Calendar{1] Passed [=] =] 91672005 300 AM 9
Server Mo Run || Service Class Preference[1] Passed || (=] 9272005 300 AM 1=
Mo Run [+ Flight Time Preference]1] Passed |w| [ ] 916/2005 3:00 AM i1
Mo Run [« ] Range of Dates[1] Failed  [] [=] 91/2005 3:00 AM 1
Mo Run [ | Number Of Passengers[1] Passed || [ | 3272005 3:00 AM 1
Mo Run [ Trip Type[1] Passed |w| [ 10/21/2005 3:00 AM 1
Mo Run [+ Passenger Name[1] Failed [«] [=] 916/2005 3:00 AM i1
Mo Run [ | Credit Card Number[1] Failed [« [ 31772005 3:00 AM 11
Mo Run [+ ] Credit Card Expiration Date[1] Passed |w| [ 911/2005 3:00 AM 3
Mo Run [« | Credit Card Owner{1] Failed || [=] 913/2005 3:00 AM 23—
Mo Run [+ Billing And Delivery Address([1] Passed || [=| 913/2005 3:00 AM  :2
Mo Run [ | Address Options[1] Failed || [=] 914/2005 3:00 AM i1
Mo Run [+ | Flight Confirmation Navigation[1] Passed |w| [ ] 9/25/2005 3:00 AM i1
Mo Run [+ | Flight Cost By Passengers Quantity | Passed [« [= | 3/13/2005 3:00 AM 11
Mo Run [ | Flight Cost By Service Class[1] Failed || || 9/20/2005 3:00 AM i1
Mo Run [+ Billing And Delivery Address(2] Passed |w| [ 916/2005 3:00 AM 3
Mo Run [+ User Name[1] Passed || L= 10/21/2005 3:00 AM i1
Mo Run [« | Password[1] Failed || [ ] 10/24/2005 3:00 AM 1
M| b NoRun [ | Confirm Password[1] Passed || [w] 91/20052:00AM 1 _
Local Test..| TestSet  |Requiremn... < | — 1] — T o oo T Temmmm o r“
FastRun OffRoad 5/24,/2008 9:33:58 executed

Note: Some of these buttons are enabled only if action is possible in currently selected view.

Load new Test Set is used to download new data from Quality Center server. More information in chapter
Downloading of Requirements, Test Sets and Defects.

Save is used in all places where data can be modified to save all data to local data storage.
Add Entity is used to add new defect or attachment.
Remove Entity is used to remove currently selected test set, defect, run or attachment.

Upload Results to Server sends all added and modified data to Quality Center project. More information on
this is found in chapter Upload Results.

Select grid columns opens an editor to select columns for currently open grid. More information on this is
found in chapter Selecting Grid Columns.

Print selected grid opens a print preview window from current grid and from this window it is possible to
print currently selected grid.

Create new run for selected test case opens Manual Runner to execute new run for selected test case.
More information on this in chapter Test Execution.
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Back to Test Cases Node moves currently selected node in Test Set Tree view to Test Cases node which lists

all test cases in current test set.

All of these toolbar options are also available through menus and in those there are also few other options.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAUI_"I:';

Execute Run - 5

File | Edit Options Window
[ Open... Ctrl+0
I Save Ctrl+5
Send Results..., Ctrl+R
Cloze Ctrl+L
Import Test Set...
Export Test Set...
Create Test Set...
Print Grid
Exit Ctrl+E

Picture 4 File Menu Options

Help

La=st Run
Status

-

¢

[~]

b (Failed

Mo Run

[:;'_E_ Airline

Mo Run

Mo Run

Mo Run

Mo Run

Mo Run

Mo Run

Mo Run

bl R

In the File menu there are extra options to

e Close currently open test set. This saves all changes and clears main window.

e Import and Export Test Set. This enables OffRoad to send and receive data through files. More
information on this in chapter Importing and Exporting.

e Create Test Set allows user to create new test set from the currently open test set. More

information on this is found in chapter Create Test Set.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter Demo

Picture 5 Edit Menu options

. ,\‘.\’-‘*I"‘u.’lr

umi

File | Edit | Options Window Help j
FHE Cut Ctrl+X -3 -
Test S Copy Ctrl+C '
B-E Paste Ctrl+V <t Bun

: Test Name
= Delete Ctrlsp  [SiolUs
Find Repl .l =l
n ERoet =d w [ Airline Preferencel1]
Select All Ctri+A Run L= Departing And Arriving Locations[1]
Fun |w | Departing Date]1]
Add... F2 Run [« | Returning Date[1]
Execute Run 3 Run | » | View Calendar[1]
. Run [« Service Class Preference[1]
Execute Run (Mini Runner] F4 Run [ ] Flight Time Preferenceli]
Execute Run (Maxi Runner) F5 Run [w| Range of Dates[1]
| Grid 4 Select Columns Ctrl+1
N Reset Row Height  Ctrl+R

_i ration Dat_t_a[1]

o
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In the Edit menu there are common actions for cut/copy/paste which are used in different edit fields and

can be used also through associated shortcuts.

Find Replace brings up an special dialog to do find replace actions in selected grid. More information on

this can be found in chapter Find Replace.

Grid menu has extra option to Reset Row Height. This affects current grid so that while column width stays
the same, grid row height is adjusted so that all text fits into cells.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAUI_*

File  Edit | Options | Window  Help

rRC Show Test Set Path n - @
Detect Metwork

=- El Test Set I Last Run
[=- E Mercuny Tours Functionality Status

B 48 Defects (75

Picture 6 Options Menu

Show Test Set Path is checked by default and if unchecked it will show a flat view of test sets without the

folders:

Page | 5-17



) OffRoad - Test Set: Mercury Tours Functionality D

Y

() OffRoad - Test Set: Mercury Tours Functicnaliﬁ'

File Edit Opticns  Window  Help
L |0 (8 | & Execute Run -~ @
Local Test Sets

El--i—"g Local Test Sets
=- B gc92
E--l]] DEFALULT
= [ GualityCenter_Demo ’
=@ Mercury Tours Web Site 3
E- 'ﬁ Functionality And LI
P [ Mercury Tours Functionality
B 'ﬁ Performance And Load
----- [£] Mercury Tours Loading
=- % Release 105 )
- f:'jr Cycle 1 .
----- [£] Mew Features
= f:'jr Cycle 2
----- i [2] Mew Features
..... D Regression
= f:'jr Cycle 3
..... D Sanity
= f:'jr Cyce 4
----- i [2] Mew Features
..... D Regression

=- f:fi' test

File Edit Opticns Window  Help
G H | [T# | &% Execute Run
Local Test Sets

Eli—':% Local Test Sets w
B- g qc32
=k l]] DEFAULT

E- [J GualtyCerter_Dema
E Mercury Tours Functionality

D Mercury Tours Loading
New Features
New Features
New Features
Fegression
Fegression

D Sanity
D Sanity
- [2] testset not to be found

DDDDD

Show Test Set Path option not
checked

Local Test Sets |Tﬁt Set| Requirememsl

»
T
----- [£] testset not to be found
Show Test Set Path option
checked
Local Test Sets | Test Set | Requiremenml
T T

3
;
j

In case of issues with OffRoad main window layout there is an option in Window menu to Reset Window

Layout:

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFALULT ije:;‘t.“:i

Eli—"g Local Test Sets
B- _!;' qc32
El- l]] DEFALULT
E- [ GQualtyCenter_Demo

MMIM Al

Picture 7 Reset Window Layout

File Edit Options | Window | Help
& H i | Reset Window Layout
pcal Tes : 0

This option clears current window locations and sizes and returns the default options.
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5.2 Saving Changes in OffRoad

All changes are saved automatically when moving between views.

It is also possible to save changes using menu or toolbar commands:

) OffRoad - Test Set: Mercury Tours Function;'_

Edit Options Window  Help
Execute
) OffRoad - Test Set: Mercury Tours F’
File_ Edit Opticns  Window Close ChrleL l
80 | %@eg '
— Import Test Set...
Tesi 5et
E- [E] Test Set _ Export Test Set... ;
=) |E| Mercury Tours Functionality Create Test Set...
. ® Defects (75) _ _
|2 Attachments {m Print Grid
it I | T
Defects (. ’ .

When creating new Defect, it is also possible to save (or cancel the defect creation) using buttons on the

form:

-
) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

=Y e 5

File  Edit

GHO

Options ~ Window  Help

- =] Execute Run - @

Summary

Details | More Info I Comments I .Pd‘tachmentsl

" Test Cases (36)
- [E] Al Runs (1)
i [E] Al Defects (75)

Actual Fix Time

* Detected By I I

*Defected on Date 5/24/200810:39:33
* Reproducible ]
° Severty Iﬁ
csmws [ =]

Defect ID -1

Description

Closing Date I Vl

Closed in Version

R ,
Local Test..| Test Set Requirem...l

FastRun OffRoad 5/24,/2008 9:33:58 executed

Picture 8 Defect Form

More on Defect handling can be found on chapter Defects.
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5.3 Downloading of Requirements, Test Sets and Defects
When launching OffRoad for the first time, Select Test Set dialog is shown automatically:

.
© Select Test Set E@Q

File  Options

T Load...

Cancel

From this window it is possible to download new requirements, test sets and defects from Quality Center
by selecting Load —button.

Fill in Quality Center url, user name and password and press Next:
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) Get Test Set From Server

Login
Erter your login information

Server URL: hitp://qc92:8080/qcbin

|Isemame: ilpo

Password:

A

.

Please not that Server address looks like one above. Do not add anything after the qcbin. Address should
only include server name, port (if not the default port 80) and qcbin. If your server requires using https

instead of http, change that to the url.

Now select Domain and Project and click Connect:
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) Get Test Set From Server @ﬂu

Test set selection
Select test set(s)

Domain: | DEFAULT -]

Project: | QualityCenter_Demo -|

Test Set Tree | Test Set Fiters

Cthers

Include Attachments

Once connected, select one or more test sets:

.
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) Get Test Set From Server

Test set selection
Select test set(s)

Connected to server: hitp ://qc92:8080/qcbin

Domain: [ DEFALLT
Project: | QualityCenter_Demo

Disconnect

Test Set Tree | Test Set Fiters

Elli| i Test Sets
- [] 7] BPT tests (Flight)
w-E ¢l Cﬂmple‘ted BPT Tutoria

il {,,I Ferromance And Load
------ ¥ [Z] Mercury Tours Loading

- D{ﬂ Release 10.5
- [ ] test

Cthers

Include Attachments

You can also take attachments (default) or leave them on the server by checking/un-checking Include

Attachments —checkbox.

It is also possible to download test sets using a private test set filter defined in Quality Center client
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) Get Test Set From Server

Test set selection
Select test set(s)

Connected to server: hitp ://qc92:8080/qcbin

Domain: | DEFAULT -]
Project: [Qualii}{:enter_[]emu v]

Disconnect

Test Set Tree | Test Set Fiters
asdfasdf

Iy test set export filter

Cthers

Include Attachments

This dialog shows all your private test set filter.

.

After you have selected your test sets, click Next.

Here is three optiosn:

1. Include Filtered Defects
2. Include All Defects
3. No Defects
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) Get Test Set From Server El&lg

Defect Filter Selection
Select fitter for defects

Private Defect Filtters

e T —

Include Defects

() Include Filttered Defects
() Include All Defects

@ Mo Defects

Filtered defects gets all your defects based on selected private favorite created on Quality Center client.

.

Include All Defects takes all defects out from Quality Center into OffRoad.

No Defects leaves all defects to Quality Center, only defect customizations are taken to OffRoad.

After select Next from above
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) Get Test Set From Server

Requirement Selection
Select Requirements

35

- 1 Mercury Tours Application

H..[] il Online Travel Booking Services
-1 B Orline Travel Information Source
-] Bl Profile Management

-] Bl Reservation Managemert

-[_] Bl Booking System

-] Bl Application Securty

-] B Application Usahbility

.- [] pg;_‘ Task Simplicity

- vl (@ Comect Emor Messages
B[] r@a Keyboard Support

B[] r@g Speling And Language Comectness

0@ 8 EEE

----- vl r@; Generic Layout
----- v/ @ HTML Pages Identfication

----- vl r@d Level Of Importance Consideration
----- [ r@d Limited Page Length

----- | @ Limited Page Text Length

----- vl r@d Page Blements Alignment

----- O r@i Readable Forts

----- [ r@; Clear Links

-] i Fom Elements Comectness
Application Client System

Application Performance
.. ] L Page Download Time
L Transaction Response Time
™! Ppplication Reliability
L Fail-Rate

!

=[] I7 Wehb Page Structure And Layout Consistency

m

-

Requirement selection is similar to selecting test sets, it is possible to select all or only some of the

requirements to be downloaded into OffRoad.

If child requirement is selected, also all parent requirements are selected.

Note, icons seen in this tree are the ones defined in the Quality Center project.

Then select Next to verify your selections:
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L

O Get Test Set From Server

Confirm selections
Test sets selected for download. Click

Test Set Mame

Root'Release 10.5'Cycle 1\MNew Features
Foot'Release 10.5Cycle 2\New Features
RootRelease 10.5Cycle 4'MNew Features
Root'Release 10.5Cycle 4'Reagression
Root*Release 10.5Cycle 2Reagression
Root*Release 10.5Cycle 4'S5anity
RootRelease 10.5Cycle 3\Sanity
Root'Release 10.5'estset not to be found

Root'Mercury Tours Web Site'\Functionality And UNMer...
RootMercury Tours Web Site'\Peformance And Load...

Download Status

Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download

Download begins when you select Finish.

During the download operation you can follow the progress:
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) Get Test Set From Server

Confirm selections
Test sets selected for download. C

Test Set Mame

@ Root'Mercury Tours Web Site'\Functionality And UNMer...
RootMercury Tours Web Site\Performance And Load...

Root'Release 10.5'Cycle 1\MNew Features
Foot'Release 10.5Cycle 2\New Features
RootRelease 10.5Cycle 4'MNew Features
Root'Release 10.5Cycle 4'Reagression
Root*Release 10.5Cycle 2Reagression
Root*Release 10.5Cycle 4'S5anity
RootRelease 10.5Cycle 3\Sanity
Root'Release 10.5'estset not to be found

Download Status

Done!

Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download
Selected for download

s

Once download has finished, following happens:

1. If you had selected only one test set, that is opened already and you are ready to start executing

tests and working with defects

2. If you selected more than one test set, Select Test Set dialog is shown:
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) Select Test Set

File  Options

=l [ ] ¥4 Local Test Sets

-] 5 qc92

=0 l]] DEFALLT
B[] [ QualityCenter_Demo

-1 % Mercury Tours Weh Site
- [ % Functionality And Ul
[ D Mercury Tours Functionality
El- [ % Peformance And Load

[ [£] Mercury Tours Loading
=[] ¥ Release 105
B[] @ Cycle 1
te.[] [2] New Features
B[] & Cycle 2
- [] [£] New Features
.. ][] Regression
B[] & Cycle 3
fe ] [2] Sanity
B[] 4 Cycle 4

~-[] [£] New Features

-.[] [] Regression

fe[] [2] Sanity
E- ] P test

.. [] [3] testset nat to be found

Load...

Picture 9 Selecting local test set

More on how to work with this is in chapter Selecting Local Test Set.

5.4 Selecting Local Test Set
There exists two ways to select test set to work with:

1. Through File->Open —menu (See Picture 8 Selecting Local Test Set through menu)

2. From Local Test Set tab in Main Window (See Picture 9 Selecting Local Test Set from Main Window)
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) OffRoad - Test Set: Mercury Tours Functionality I{'

File | Edit Opticns  Window  Help J
ﬂ| Open.. Ctrl+0 |k Execute Run =

Save Ctrl+5 E

Send Results... Ctrl+R

Cloze Ctrl+L

Import Test Set...
Export Test Set...

Create Test Set...
f.ﬁ\wﬂnﬁpl"hﬂﬂuﬂih“‘-."hu

Picture 10 Selecting Local Test Set through menu

@ CffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT I?
File Edit Opticns  Window  Help

G H O - RN Execute

Local Test Sets
=54 Local Test Sets
=- B gc92
E--l]] DEFAULT
= [ GualityCenter_Demo
=1 % Mercury Tours Web Sit

Double
Click to
open | -

FI 3 _ The Ilsg

----- i [ Mercury Tours Functionality

----- .. [2] Mercury Tours Loading
=- % Release 105
- f:'jr Cycle 1
----- [£] Mew Features
= f:'jr Cycle 2
----- i [2] Mew Features
..... D Regression
= f:'jr Cycle 3
..... D Sanity
= f:'jr Cyce 4
----- i [2] Mew Features
..... D Hegressmn

-Select Local
Test Set from

Local Test Sets )St Set| Requiremenml 4
FastRun OffRoad 5/24/2008 9:33:58 executed

Picture 11 Selecting Local Test Set from Main Window
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When selecting menu File->Open it opens Select Test Set window which is used to

Select already downloaded local test set

2. Select and download data from Quality Center server (See Downloading of Requirements, Test Sets
and Defects)

3. Import Test Set package (See Importing and Exporting Test Set)
Delete selected Test Set(s) or all of them (See Managing Local Test Sets)

s N
) Select Test Set E=NEER™

File  Options

_!‘5 Local Test Sets Load...
E’ qc92
|j] DEFALLT
B[] [ QualtyCenter_Demo
=8 '?.3}‘ MEI‘C:IJF_." Tnurs Web Site

=
D I"-"Ierl::ur'_.r Tours Loading
[=]-- '?.3]? Release 10.5
B- & Cycle 1
. Y cD |NZW Features Select Local
... yole
D MNew Features TESt SEt
[] Regression
= '?fj? Cycle 3
= 'i"‘ﬂl? C‘,’C'E
: D MNew Features
[] Regression
D Sanity
B 3 test

- D testset not to be found Click Dk tﬂ Dpen
selected Local
Test Set

S

e

Picture 12 Select and Open Local Test Set

Select Test Set dialog shows the same view as on Main Window and local test set can be opened from here
by

1. Selecting local test set
2. Click Ok —button or double click test set name
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5.5 Requirements

To view requirements, select first the Requirements tab to switch view

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFA

U
File Edit Opticns  Window  Help ;
= H (% JR" | Execute Run - £3
Test Set -~
B- E] Test Set

=- (=5 Mercury Tours Functionality

[Download
!- Defects (75) Diescription
- =] Atachments (0)
[ 5 Test Cases (36) ummary
—[E] Al Runs (1) g{e:n:u.t}rT i
. E] Al Defects (75) depth v
System Fiekd
Close
Test & 4
Cpen f
ITG Requesl®
Select Requirements Hser Defines

tab to switch view

4 | ]

Local Test Sets | Test Requirementsl )

{

If there are linked test cases for these requirements and they were also downloaded these are listed in this
view and by double clicking test case name, it goes to the selected test case.

Picture 13 Switching to Requirements
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@ OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

File Edit Options Window

G H O &

E- | Requirements
E|_J Test folder requirement
TS asdiands
(G et Comtec: rromeron ]
or |
(Contact Information)[1]
q Information[1]

Help
Execute Run ~ &

Design Test Case: Change Email (Contact Information)
System Fields

_ {fv Change Ph
- £ Change M

Test Case linked
into selected
Requirement

.| 1 | 3

The test verifies the Email field in the Contact Information section on the Edit Profile page.

Limitations

In order to execute this test, the tester should be familiar with the profile registration
procedure.

T _otoaro

Details | SA Codes

Creation Date | 03/14/2005 ] Status | Ready [
Type |MANUAL [
g f0 goto this |
Test Case
4| m 3
Description
Summary i

m

User Defined Fields

* Reviewed I Reviewsd Reviewer Ishelly_qc

Local Test Sets| Test Set l Requirements

4 i |

Picture 14 Viewing Test Cases linked to Requirement

5.6 Test Execution

Test Execution is all about creating new runs and defects. This includes selecting correct test case for

execution, reading test case and step descriptions and selecting values for run and defect fields.

There can be mandatory fields for run and defect, these are marked in red. Test Case can also have
mandatory fields which need to be filled before run is executed.

Test Execution is done either using one of Manual Runners (Manual Runner/ Mini Runner / Maxi Runner) or

Fast Run.

Manual Runners guide testing through steps, Fast Run is just selecting correct Run Status in the Execution

Grid and saving it.

5.6.1 Manual Runner

To open Manual Runner, select Execute Run —button from toolbar or from menu Edit->Execute Run.
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File Edit Options

G H o

Picture 15 Open Manual Runner

Window

ﬁ Test Cases (36)

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAL{

@ CffRoad - Test Set: Mercury Tours Functionality Domain: DEFI

File | Edit | Options Window Help
@ H Cut Ctrl+X
Test 5 Copy Ctrl+C

Paste Ctrl+V
Delete Ctrl+D
Find Replace

Select All Ctrl+4
Add E?
Execute Run F3

Grid

Execute Kun (Mim Runner] k4
Execute Run (Maxi Runner] F5

Picture 16 Open Manual Runner though menu

m Pl??

Descript

Opening of Manual Runner is enabled only if you have selected proper node from local test set tree:

- Test Cases node. In this case it starts to execute currently selected test case from Execution Grid

(See Picture 15 Execute new Run for selected test case in Executin Grid)

- Any node under test case (See Picture 16 Execute new Run for selected test case from local test set

tree)
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oad - Test Set: Mercury Tours Functionalr omain: roject: Qua enter_Demo 4
OffRoad - Test Set: M ry T F ionality D in: DEFAULT Project: Quali De ’
File Edit Options Window Help .
EH # | E 0 | 5 Execute Run -
Test Set -
= E] Test Set Last Run
=- E] Mercury Tours Funcionality Status Test Name
. Defects {75
T8 ke (B =
: Failed [ Airline F’refereu:eﬁ]
E Al Defeds (75 } [Na Run T[)e:ﬂ'hrg Date[1]
tiorFom z m“
Mo Run [ | Wiew Calendar]1]
Mo Run z Service Class Preference(1]
Ma Run z Flight Time Preference[1]
Mo Run [« Range of Dates[1]
WS Bl IO NSV SN S T owww

Picture 17 Execute new Run for selected test case in Execution Grid

) OifRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

File Edit Options Window Help

FH O = | 5 Execute Run ~

Atschment:

= E] Test Set « | € Add ~ () Rernove

=- |§| Merzcury Tours Functionality i

. & Defects (75) Mame Size
----- |=] Attachmerts (0}

['ZI @& Test Cases (36)

- 50 Address Options[1]

(- &34 Aifine Preference(1]

a:;} Emnng And Delwery Mdress[‘l]

Execute Run
creates new run
this test case

- g§ Des:gn Steps
- 45 Run Parameters

"R

----- -f:‘* Test Runs {D}

; ...g Defects (0}

-5 Cancel Checked Reservations[1] =
- &5l Changs Email (Contact Information)[ Description
-- &5l Change First & Last Name (Contact |

b, vEhan "'Mf aorntel BN o W «-—ur

1| m

Picture 18 Execute new Run for selected test case from local test set tree

After selecting Execute Run Test Run view is shown:
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@ OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

4

[]--@' Cancel Checked Reservations[1]

[]--ﬁd Change Email (Contact Information)[1]
[]--ﬁu— Change First & Last Name {Contact Inform:
[]--ﬁi‘ Change Mailing Information[1]

E]--{ﬁi‘ Change Phone (Contact Information)[1]
[]--@' Carfirm Password[1]

. £ Credit Card Feniration Natel11

“: Run Parameters
|=] Attachmerts (0)
- £55 Test Runs (1)
= 63 IO Rioad 5/25/2008 11:00:29:
,99 Run Steps (11)
=| Attachments (0}
- @ Defects (0)
L. 4 Defects (0)

L1 2

Local Test Sets | Test Set Requirements|

File Edit Options Window  Hel
G H (< WR" | (| &% Execute Run -} @
Test Set 4 =25 Bl Test Run: OffRoad 5/25/2008 11:00:29

Test Set » || Run Fields
Elm ||| Exec Date 5/25/2008 11:0029 Opergling Svetem kfo

R ect_ Xecute ate 0

- 2 umnagain to move Host IVISTA
EI" i ‘imﬂRUI? Steps Status |Nm Completed ;I
= gae Lintianal .
1 * Tester Iali{:e_q{: ;I

User Defined Fields

Language |Z|

Test Case Description
Summary

The test verifies all reservations cancellation from the Itinerary page.

Limitations
In order to execute this test:

1. The tester should be familiar with the profile registration procedure.
7 The tactar chnnld ha familiar with the licht racarmration nracadire

m._|»

Picture 19

Test Run View

On Test Run view verify run fields, test case description for instructions and then select Execute Run again

to move

into Run Steps:
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@ OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo E@g

File  Edit Options Window Help

EEHO = Bl {:"ExecuteRun -2

Test Set el Run Steps * I
Test Set - 'l u v| ﬁ!:l T
_H ol L
- E Mercury Tours Functionality — — —
-
[]S Eﬂi;d:_lgf: o Status Step Mame Description Expected =
Elffi) Test Cases (26) Mo Run Connect to Open your Web browser and The Mercury Tours site opens. | |E
-- {@ Address Options[1] | 3 w | Mercury Tours | type the <<<Mercury Tours
- £ Airine Preferencel1] 3 - Dl
- &0 Biling And Delivery Address[1] Mo Run Initialization ; Hegsm:id new L;_;er profiles.
B3 Biling And Delivery Address{2] ﬁamb.mﬁhﬁm'“gﬂmml .
Eﬁ Cancel Al Reservations[1] follows:
[h Attachments (1) - First user without a flight
B ¥ Design Steps T v reservation : .
EQ‘?HU gP e'; - Second user with 1 flight
n Farameters resenvation
-2 Attachments (0) - Third user with 3 to 10 flight
E|--%:"‘ Test Runs (1) reservations
- £ OffRoad 5/25/2008 11:0029 | PR R .
. Mo Run Connect to Open your \Web browser and The Mercury Tours site opens.
i {m N - rh:!_ermy Tours Hihe <z<Mercury Tours -
- ’-_ Defects (0) Step Description

"— Defects {0}
H- {?} Cancel Checked Reservations[1]
]ﬁu Change Email (Contact Information)[1]
]ﬁu Change First & Last Name {Contact Inform: —

[z Open your Web browser and type the <<%,
[

[

- £50 Change Mailing Irformation[1]

[ £50 Change Phone (Contact Information)[1] EREHEe Actual Resut
B £5 Confim Password[1]

i

. &5 Credt Card Fariration Natel1] ~ || TheMercury Tours site opens.

f 1 b
Local Test Sets | Test Set Requirements| il >

Picture 20 Run Steps View

Run Steps view is used to record run results for each run step. For this there are few alternatives:

1. Select Pass/Fail step from toolbar (See Picture 19 Pass or Fail step using toolbar buttons).
Select Pass All Steps / Fail All Steps using toolbar (See Picture 20 Pass All Run Steps or Picture 21
Fail All Run Steps).

3. Change Run Step Status in Run Steps Grid (See Picture 22 Select Status for Run Step in Run Steps
Grid).

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo N

File Edit Opticns  Window  Help

EFH O W |0 (8 | 58 Execute Run ~ §9

Test Set LB Run Stens
Test Set - f‘l:| r :
— m —
- [E] Mercury Tours Functionality ( — '
- B Defects (75) v
Stat Step M [es .
5] Attachments (0 LS ep Name cri
Ma to

o

] wﬂ Cases (36) J

Picture 21 Pass or Fail step using toolbar buttons
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo f

File Edit Opticns  Window  Help

FH O W |0 (8 | 5 Execute Run ~ §D

Test Set > R
Test Set #Iv] “: f‘: I
]
- [E] Mercury Tours Functionality —| —|
. B Defects (75) Pass Selected Ctrl+P
- [E] Atachments (0) Pass Al
El @ Test Cases (36) . pen your Wleb
. B 550 Address Options[1] 3

Picture 22 Pass All Run Steps

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo e

File Edit Opticns  Window  Help '
EHO @ | (9 | &8 BrecuteRun - .
Test Set Ll Run Steps

Test Set e
- |£| Mercury Tours Functionality ¥

. ¥ Defects (75) Fail Selected Ctrl+F

----- |J Attachments ()
El 1:59 Test Cases (36)
: -5 Address Options[1] | 3

M- £ Airine Preference(1]

Fail All

v Cu

m

" : URL::}:: y
Mo Run Iuhdlzatm ster 4
e,

Picture 23 Fail All Run Steps
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT

Project: QualityCenter_Demo

File Edit Opticns  Window  Help
FH O W |0 (8 | 5 Execute Run ~ §D
Test Set a
Test Set -
- [E] Mercury Tours Functionality i
I # Defects (75)

- =] Attachments (0)

EI-- " Test Cases (36)

[#- 50 Address Options([1]

- % Aifine Preference(1]

- &0 Biling And Delivery Address[1]

m

=] Attachments (0)
El--f:'* Test Rune (1)
=4 OH'HDEI::I 5;*25;*21][13 11:00:29

s

rhd

Step Mame Description
to Cpen your Web browser
Tours |type the z=Mercury T

URL==z,
1. Register 4 new user

- & Biling And Delivery Address[2] Hi""ﬁun fﬁc'm“":ﬁ?;m“mg“
=- ;5;, Cancel All Reservations[1] Mot Completed follows:
..... [y Attachmerts (1) Passed irst user without a
£ L | resmahm
l .95’ Design Steps - Second user with 1
EI ?-ﬂl Run Parameters reservation

- Third user with 3

Picture 24 Select Status for Run Step in Run Steps Grid

Ending of Run is done using End Run —button:

Picture 25 End Run —button

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo :
File Edit Opticns  Window  Help J
GEH QO 8| 0 5 murn - Q End Run
-button
Run Steps
El ?,H Run Parameters ~ P~ 3B~ rEl
ﬂ L i
5 Atachments (0) T - (
E|" E:‘I_‘:: ;:"Zﬂopflfuﬂr:ag}ﬁ Status Step Mame Description
""" 99 Run Steps (0) WE:"F'IH_ 'Dpen your Web browser and
g = c:hments 0] oy {f: Tuq.rs

It is also possible to switch between Mini Runner and Maxi Runner during the execution by selecting the

runner type from toolbar:
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) OffRoad - Test Set: Mercury Tours Functionality

Domain: DEFAULT Project: QualityCenter_Demu;

Picture 26 Switching to other Runner type

5.6.2 Mini Runner

File Edit Opticns  Window  Help J
FH O W |0 (8 | 5 Execute Run ~ §D L
Test Set = o N 21
[=- {7 Fun Parameters - = = m

ol v~ %~ (G-
- =] Attachments (0) - -
5. EE Mini Runner
= E:“-'g I?St Funs (1) Status ipticn f
EJ- 4 OffRoad 5/26/2008 | Maxi Runner
#¥ Run Steps (0) Mo Run 3 browser and
- =] Mtachments (0) | ] - : Tours
... Defects (0) L Site EURL}:‘}.
- :.. Defects (0) Mo Run Sign-On to 1 Type the <z<User Name==%,
@ Departing Datef1] Mercury Tours {in the User Name field.

ST

Mini Runner has similar functionality as Manual Runner, but it has no Run Step grid.

You can Pass or Fail one step at a time by selecting the toolbar button or by changing Step Status.

Offfoad - Test Set: Mercury Teurs Functionality Domain: DEFAULT Project: QualityC...

",

File

Edit Options Window

Help
Run Step: Connect to Mercury Tours Site

v B @ O

Step Mame 1/6

el m

Always on top |3t
w

Connect to Mercury Tours Site_ [

Step Results | More Info | SA Codes |

Step Description

Open vour Web browser and type the <<=

Expected Result

The Mercury Tours site opens.

-

%

Actual Result

Picture 27 Mini Runner & Always on top —button

It is also possible to keep Mini Runner on top of all other windows on the system by selecting the Always on
top —button. To release window select either End Run —button or again Always on top.
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5.6.3 Maxi Runner
Maxi Runner is same as Mini Runner, but with larger buttons and text.

OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

vRaw

Step Name 1/6 Step Status
Connect to Mercury Tours Site No Run j

File Edit Options Window Help
Run Step: Connect to Mercury Tours Site

Step Results | More Info | SA Codes|
Step Description

Open your Web browser and type the <<=,

Expected Result Actual Result

The Mercury Tours site opens.

Picture 28 Maxi Runner

5.6.4 FastRun
Fast Run is a method of recording run result without executing run steps. Fast Run will create actual run,
but without marking Run Steps with a Run status.

Fast Run is done in Execution Grid by changing the value of Last Run Status column and saving the grid
either by selecting Save —button or moving focus to Test Set Tree.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

File  Edit Gptiﬂns Window  Help

.
4

”‘* Execute Run -
o
Test Set - 0
= ﬂ? TEStCE'SES{EE} it Last Run Status On
! £50 Address Options[1] h Status Test Name Server Tester
- i Aifine Preference(1] =
- b—} Ei:fhnm;;’tss{”} Not Com [ ] Aurline Preferencel1] Passed
-~ = Not Com [« | Departing And Arriving Locations[1]  Passed
M un Parameters | ||| oSLITEE - :
_____ 2] Attachmerts (0) Not Com [ | Departing Date]1] Failed
EI---';,?E Test Runs (2) Failed E| Returning Date[1] Failed
- ‘:ﬁ OFfRoad 5/2 p |Mo Run :E = Cden:lalﬂ] Pazsed
Eﬂ OffRoad 52 e O
""" # Run Ster Mo Pun ligh
----- =) Attachme Exe'cute Fast Run
- Defects{ || |Passed by changing the

H- 8 Defects (0)

- &0 Biling And Delivery Addre Lﬂﬁt Run Status
- é'a.. Billing And Delivery Addre

[#- ;;._?“ Cancel Al Reservations[”

- &8 Cancel Checked Reserv || e

-£50 Cancel Checked Reserv: Credlt Card Dwner[‘l]

Lossnt Crargsgrai oo L g 1S e

Picture 29 Fast Run

You can see a Status Bar message after Fast Run has been executed:

- -

il "!/' Ilg"—./i'.:rU"'--"‘.r":"“"'.-'."—’ﬂ"."l-’r"_'v
- &5 Credit Card Owner]1]

! [ 574 Nenartina And Amivina e T

4 L | I

Local Te..| Test Set | Require... |
FastRun OffRoad 5/26/2008 19:36:31 executed

Picture 30 Fast Run Status Bar message

5.6.5 Run Status Rules
Depending on the status of the Run Steps following Run Status Rules apply. Whole Run Status is calculated
based on these rules.

If all or one of the Run Step status is set to No Run, whole run is set to Not Completed.

If all or one of the Run Step status is set to Not Completed, whole run is set to Not Completed.
If all Run Steps are set to Passed, whole run status is set to Passed.

If all Run Steps are set to N/A, whole run status is set to N/A.

If one of the Run Step is set to N/A, whole run status is set to Not Completed.

If one of the Run Step is set to Failed, whole run status is set to Failed.

No v ks wNR

If all or one of the Run Step is set to No Result, whole run status is set to No Result

Note: No Result run status is a custom run status value which can be added to the list of possible Run
Status values through Quality Center project customizations.
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5.6.6 Continuing Manual Run
OffRoad has no different functionality for continuing already executed manual run. In OffRoad this is seen
same as editing existing run. For more on this, see Editing Run.

5.6.7 Editing Run
To change already existing run you just need to find it first. For this there are few alternatives:

1. Find run from All Runs grid, double click the correct run row and run is selected from the Local Test
Set tree.

2. Select Test Case from Execution Grid with existing run, double click the test case row to select Run
Parameters node. Expand Run Parameters node and select Test Runs. From opened Test Runs grid
you can select the correct run by double clicking the row. This will move focus to the run.

3. Expand Local Test Set Tree to find correct run node and select this.

If run is not yet uploaded to the Quality Center server, it is still editable and all changes to it are saved.

After selecting Test Run, you can also move to the Run Steps node and default Manual Runner is visible
again. From here you can also select Mini Runner or Maxi Runner to your view.

5.7 Defects

It is possible to edit all defects in OffRoad regardless of upload status. Defects are not locked against editing
and all changes to these are uploaded during the next connection to Quality Center project.

New Defects can be added to

1. Test Set
2. Test Case, defect is added and linked to specified Test Case
3. Test Run, defect is added and linked to specified Run

Note: When adding new Defect to Test Set, it is not linked to any entity on Quality Center project.
Functionality is the same as when adding new defect directly in Defects side of the project.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Qualin{enter_?

File Edit Opticns Window  Help
@ H @ @ ﬁ 7] Execute Run
Test Seat - I

Add new Defect
to Test Set

& _ The list of flights is given even when pas
The list of available flights is not given wh
The list of flights is given when departing da
Mathing happened when clicking View Cal

The list of flights is displayed when an ill
If there is an error when submitting the reg

Picture 31 Adding new Defect to Test Set
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¢ Run Parameters
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: r

- iy Aifine Preference[1] =

[l £ Credit Card Expiration Date[1

[+ &5 First & Last Name
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.1y Attachments (1) Test Case

ANy A Ny,

FastRun OffRoad 5/26/2008 19:35:31 executed

Picture 32 Adding new Defect to Test Case
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OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Qua.i."'"
ry ty J }
File Edit Opticns  Window  Help

FHO & | f (9 | &8 ExecuteRun ~

Test Set -
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=l Fﬂ Departing Date[1]
----- Oy Attachments (1)
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= 4 HII Run Parameters
- |=] Attachments (0)
E--;;‘": Test Runs (4)

¥l {7 OffRoad 5/25/2(

'
[ o OffFoad 5/26/2(
¥l i OffRoad 5/26/2(
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=- $¢ Run Steps (§
- g9 Connect
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[
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[H- 50 Flight Cost By Passengers Qu
[H- 50 Flight Cost By Service Class[”
[+l {55 Flinkt Time Preferencel11 i
I

Local Test Sets | Test Set Requirement5| loom
FastRun OffRoad 5/26/2008 19:36:31 executed

P

Picture 33 Adding new Defect to Test Run

After selecting the Add new defect form is opened. Mandatory fields are marked in red and these are the
same as on Quality Center side.

After all defect information is added, select Save —button to save new defect to OffRoad’s local storage.

If defect is not to be saved, select Cancel —button.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter Demo

Test Set * I

&
'. Defec
&5 Email {Cor
G5 First & Las
-&20 Flight Cor
-&50 Flight Cos!
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£50 Flight Time
£ Mailing Inf
£55 Number O ~
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Local .. | Test Set Requir...|
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H-
]
]
]
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H-
H-
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File  Edit Opticns Window Help
S H OO @ (08 | &5 Execute Run ~ &

Summary

Details | More Info | Comments | Attachments |

Actual Fix Time Closing Date LI
* Detected By I ;I Closed in Version
* Detected on Date  5/26/2008 20:30:47
~ Reproducible
* Severty I ;I
* Status I ;I
* Category | |E|
Defect ID -1
Description
My new defect [ B
u
i
A~
Select Save -
button to save il
new defect

FastRun OffRoad 5/26/2008 19:36:31 executed

Picture 34 New Defect form
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When trying to save defect without all mandatory fields filled in, an error message is shown:

@) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter Demo LEIE'A'
File  Edit Opticns Window Help
G H S & | [@ 08 | 5% ExecuteRun ~ &
Test Set * I -~ 1
G- i Departing » || Summary
Elpf;i Departing
D] Attact
Details | More Info | Comments | Attachments
Actual Fix Time Closing Date | LI
a Application Error ﬁ
s —
A
(Field Detected By is a reguired field. Entity ‘Defect’, Id -1. ) -
E -~
'. Defec
B &5 Email {Cor
G- G50 First & Las
B £50 Flight Cort
B £50 Flight Cost
B £50 Flight Cost
G- €50 Flight Time
B £ Mailing Inf —
- 655 Number O ~
4 - 3
Save | [ Cancel l
Local .. | Test Set Requir...|
FastRun OffRoad 5/26/2008 19:36:31 executed

L

Picture 35 Mandatory fields missing value

5.8 Attachments

It is possible to handle attachments using OffRoad. During the download process attachment from Test Set,
Test Case, Design Step, Test Case in Test Set and Defects can be retrieved together with other data. New

attachments can be added to any OffRoad entity where Attachments —node is visible.

Note: Attachments are uploaded to Quality Center server only from Test Set, Run, Run Step and Defect

entities.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo '

File Edit Opticns  Window  Help
G H OO & 5 Execute Run ~ (3
Test Set v o0 | Attachments:
Es.:? Test Cases (36) * 3 Add -~ Q) Remove d
[#- {5 Address Options[1] '
(- iy Aidine Preference]1] Name .
E{f, Biling And Delivery Addresl || | Parameters htm 70
SN Y Attachments (1) ?
[+ Diesign Steps ",
£ Run Parameters Attachments can be a

added to all Entities
with Attachments -node

. - @ Defects (0)
[#1- & Biling And Delivery Addres
(- {4 Cancel All Reservations[1]
[H- 50 Cancel Checked Reserval &
[#- £ Change Email (Contact Inf
[#- £ Change First & Last Name

i ‘“-\_.r = "IE J,Tf omlig) 1M & " '\--...\ ’ ¥ N

Picture 36 Attachment can be added in Attachments -node

Attachment type that can be added to these entities can be

- Any file attachment
- Url
- Image from Clipboard

5.8.1 Adding Attachments
To add attachment move first to Attachments node and then either

- Right click the Attachments node to bring menu visible and select attachment type you want to add
- Select Add —button from Attachments toolbar and select attachment type you want to add
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[ 50 Biling And Delivery Addres
- {,ﬂ- Biling And Delivery Addres| |
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[
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#- £ Cancel Checked Reservati
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Picture 37 Adding attachment through menu

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCen?

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_[%

File Edit Opticns  Window  Help

T H D | (5 Execute Run - 3

Test Set -
I=- E] Test Set ~ |1: @ Add ~|(D) Remove
=k E Mercury Tours Functionality ¥ .
I ® Defects (75) | File. |
|J Attachments ({) Url...
EI 1:? Test Cases (36) Paste
&- {a- Address Options[1]

El i Aifine Preference(1]
----- |J Attachments ()

----- ,QQ Design Steps
[?'] Hun Parameters

m

Picture 38 Adding attachment through Attachments toolbar

Ao\

After selecting to add File —attachment, Add Attachment dialog is show. Select the attachment from here:
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r@ Add Attachment: )
@Ovh_dj ¥ Public » Public Documents » - | 3 | | Search Fe |

‘ Organize =

Favorite Links

Name Date modified Type Size Tags

E| Documents e || Logfile.bd

(5 Recently Changed
B Desktop

75 Recent Places
& Computer

E Pictures

B‘ Music

E Searches

Ji Public

Folders ~

File name:  Logfile tt -
[ open Iv] | Ccancel

Picture 39 Add Attachment dialog. Note that this dialog is from Windows Vista

After selecting attachment and Open, attachment details are shown. It is possible also to add attachment

description.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter Demo

Help

i Execute Run ~ &3

4

[]--'— Defects (75)
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File Edit Opticns Window
GHO |
Test Set -
=l ] Test Set -
- E] Mercury Tours Functional |

m

-

Local Te...| TestSet Require...l

Attachments:
3 Add - ) Remove

MName Size Modified
Logfile 62 5/27/2008 15:42:03 )
Attachment
details
Attachment
description
f
Description

This is the log file from today|

N

Picture 40 Attachment Details

To add Url as an attachment dialog is shown to write the added url. After writing the url, select Add Url to

add this as an attachment.

It is also possible to switch to add file in here by selecting the Add File —button.

Page | 5-51



B B Oymaes  Slee ey
GH OO0 @8 & v et = O

- whe o Q) tawriee
= W T S ° °

N T Sawn ) L
e () - w T3 e el
T fek e (80
B e e
T W Daesia

“.I_AddAttad'lment =]

@ Would you like to add a file or an URL link?

AddFile | |Addurl | http://www.juvander.fi/OffRoa | Cancel

e € R e e

T
;
l

-
-ESSSSSSSSSSSSSS

f
i

5.8.2 Remove Attachment
To remove already added attachment select first correct attachment from the list and then Remove —
button from the toolbar.
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@) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter Demo
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-
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5.8.3 Open Attachment

To open attachment for viewing, right click attachment row and select Open from menu or double click

attachment and select Open.

Attachment is then opened using application that is associated to attachment file extension.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Qu?

File Edit Opticns  Window  Help
FH O 1 | 5 Execute Run ~ (3
Test Set ~ I
I=- E' Test Set - £ Add -~ {3 Remove
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Delete
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Picture 41 Open or Save Attachment though menu

@ OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

Picture 42 Open or Save Attachment by double clicking attachment row

5.9 Uploading Results to Quality Center Server

"“@ Change Phone

l ¢ Defects (0)

[H- 50 Biling And Delive
[ &0 Biling And Delive
B [ Cancel All Resen
[H- £ Cancel Checked
-- &5 Change Email (C
- &b Change First & Lz
ﬁ- Change Mailing Ir

[ Open ] [ Save ] Canc

el

File Edit Options Window Help I
EH O = | £ Execute Run ~ 3
Test Set * B Attachments:
= E Test Set o € Add ~ ) Remove ‘
=- |§| Mercury Tours Functional
& .. Defects (75) Name Size Modified
- |2] Attachments {0) Logfile et 62 5/27/2008 .
E:Iiﬁa Test Cases (36)
- &5 Address Options|
(- i Airine Preference
. |2) Atachments =|| Opening Attachment =y
- D St
Q§ ssign Steps @ Attachment: Logfile b
Would you like to open the file or save it to your -
__ computer? '

Uploading of testing results means that testing results are being send to Quality Center Server for further
analysis.
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From OffRoad it is possible to upload following data:

- Defects
- Runs
- Run Steps

If Defect was originally downloaded from Quality Center or it was already uploaded once, only changed
fields are uploaded. If defect field was changed on the Quality Center side and OffRoad, user can decide if
field is uploaded to the server or not. More information on this feature in chapter Upload Results Viewer.

To initiate upload process, select Send Results from toolbar or from File —-menu.

@ OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Pm]?

File  Edit Window  Help

G H O 5 Execute Run - (3
Test Set p L B Attachments:

4

) El Test Set Send results to server Fd + @ Remove
= [E] Mercury Tous
. % Defects (75) Mame

- =] Attachments (0)
El " Test Cases (36)
. l';'iu Address Options[
El ¢ MAifine Preference
----- lJ Fd'tad"lmemg E

Picture 43 Toolbar button to start upload of results —process

Picture 44 Menu to start upload of results —process

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT .'P'
File | Edit Options Window  Help )
[ Open... Ctrl+ 0 E Execute Run - (3
Save Ctrl+5 Attachments:
| SendResults.. CilsR || @ Add ~ @) Remove
Close Ctrl+L
MName
Imnport Test Set... ;
Export Test Set... j
Create Test Set... !
Print Grid ’
Exit Ctrl+E J
—r
¢ -5 Test Fun
l ﬁ Defects {0) J
Qe > nd D Tl it

C
¢
/

After starting the upload process, fill in username and password to connect to Quality Center project:
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter E

File Edit Opticns  Window  Help
GFH OO & £ Execute Run + (3

Send Results

. Server: qch2
Domain: DEFAULT
Project: QualityCenter_Demo
|semame: jipo
Password:

Include Attachments

Description

Cancel

. Cancel Checked
¥ §5 Change Email (Ce

‘::"#I F‘rsi&L.:

On this dialog it is also possible to leave attachment out from this upload. To do this, uncheck the Include
Attachments checkbox.

k

When upload process is on, you can follow the upload progress on the status bar:

v Eh_._ A e AT T
- §5 Credit Card Expire
- §5 Credit Card Numb #
-- £ Credit Card Owne .
-- {fﬁ Departing And Ar '

1. &% Nenartina Natell ™

«[Cm 3 i
Local Te...| TestSet | Require.. | :

Upleading Results... #

After upload has ended, Upload Results Viewer is shown which shows all added and updated entities. More
on this on chapter Upload Results Viewer-
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[ Upload Results

Upload Results: 86 ltems

Action

4 Entity Mame

e

ExistingEntityMotUpdated - 76 ltems

MNewEntityAdded - 10 ltems

f

Picture 45 Upload Results Viewer

5.9.1 How to know if something is to be uploaded?
To decide if OffRoad has data that is not yet uploaded to Quality Center server, there these places to look:

1. Toolbar and menu for Send Results —are enabled.
2. Test Set Icon has been changed from [Ainto [

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Qualii:t

File  Edit Optic

G H

I # Defects (75)
- =] Atachments {D}
2 @i
----- E All HLIr'IS 1 'I}
----- E All Defects (75)

g Window  Help
18 | &5 Execute Run » &)

=- E Mercury Tours Functionality

Failed Eg -
- ".“‘k . er

Picture 46 Not Uploaded data in OffRoad
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Load...

Cancel

L

Picture 47Not Uploaded data in OffRoad

5.9.2 Whatis uploaded?

5.9.3 Upload Results Viewer
Upload Result Viewer has two functions:

1. It can be used to verify what was updated and created

2. Force Update for items that were not updated

Reasons for items not being updated can be that

1. Field was changed on Quality Center Server and OffRoad. By default OffRoad does not update fields

that were updated on both places

2. Entity was locked on Quality Center Server. Defect can be edited by somebody else while trying to

update results for it from OffRoad
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3. Attachment with same name was already present at the entity. Attachment with the same name

can be added only once to Quality Center

On these situations it is possible to force update by

P wnN e

Expand ‘ExistingEntityNotUpdated’
Select entity to be force updated
Expand on the Action column for not updated items

Right click to show menu and select Update Server

(B Upload Results

= B [ |

Upload Results: 86 ltems

»

4

Action & Entity o

~E_Gl

Mame

It

=

m

_ | ExistingEntityNotLipdated - 76 |ten~.s"} '

FieldMotU pdatedinDffRoad

B FieldMotU pdatedIinOfRoad - 22 o

FieldMotl pdatedinDffRoad

menu

=) - Ems
ExistingEntity Mot pdated Defect  :1: 8 _ The list of flights is given even when past date set as departin : 1
EastingEntity Mot pdated Defect  :2: The list of available flights is not given when departing and returni 2
EastingEntity Mot pdated Defect  : 3: The list of flights is given when departing date after returning date 3
ExistingEntity Mot pdated Defect  : 4: Mothing happened when clicking View Calendar link jep jep2 4
ExistingEntity Mot pdated Defect  :5: The list of flights 15 displayed when an illegal date is set as thede (5
EastingEntity Motl pdated Def ; . & when submitting the registration form, all fields (6
E] ExastingEntity Motl pdated [efed Righ.t c"ck et used in Mercury Tours site 7
Action ‘row 'ta Shﬂw ield Label |

Closing Date

Coldblotl lod_t-dlo TiHD - -

Update Server: Description

TiedNoipdatedimo Road

Closed in Version

Time format used in site is inc

| | alice_gc
\- Fighelloteomtesle DiffR-= = z Detected on Date 2005-05-01
FieldMotU pdatedinOfRoad z Detected in Version
FieldMotU pdatedinDffRoad E| Comments
FicldMotUpdatedinOfRoad || Estimated Fix Time P

L

=l

e

Picture 48 Select Update Server to force field or attachment update

After selecting ‘Update Server’ row is marked on Update column as ‘True’ and Upload —button is made

active.

In the Message column there is also given a reason why update was not done on the server if field was
updated in OffRoad.

When all force update fields have been selected, click Upload —button to start the upload process again.
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Picture 49 Update Column shows True when field is marked for force update

Once upload process has ended for this new update, same dialog is shown again.

5.10 Exporting and Importing Test Set Data
Exporting Importing Test Set data from OffRoad enables data from Quality Center be saved into one file
and send it for somebody for reviewing, testing and defect management.

All data that is seen on OffRoad side can be Exported and then Imported on another OffRoad instance. This
includes Requirements, Test Cases, Design Steps, Defects, Runs, Run Steps and Attachments.

Common use for this scenario is that not all of the users have direct access to Quality Center server. In
these cases someone is taking data out from Quality Center, exporting it from OffRoad, sending it out,
receiving it back with modified data and uploading result to Quality Center (See Picture 1 Simplified
OffRoad Usage).

Note! Export saves version number of OffRoad which did the export and this version is checked again in
the import phase. If version is not exactly the same, import is cancelled.

5.10.1 Export
Before exporting is possible, Test Set must be opened. Then select menu from File->Export Test Set and
select Test Set Package location (path and file name for export package) and click Save.
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) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT ij?
File | Edit Opticns  Window  Help "
| Open.. Ctrl+0 Execute Run ~ & .
I Save Ctrl+5 Test Set: Mercury Tours Function
send Results...  Ctrl+R [Serverhttp://qc92:8080/qchin] [Domain:DE
Close Ctrl+ L [Download Time:5/24/2008 9:03:35] [Uplo
Description
Import Test Set...
Export Test Set... |I Summary The tes
Towrs site. Purpose
Create Test Set.. of the Mercury Tours functionality.
Print Grid
Exit Ctrl+E )
System Fields (
Cloze Date I
Test Set  Mercury Tours Function
- #—»-J‘ - r\‘

Picture 50 Export Test Set

) Export Test Set to File...

i
@th_d) ¥ Public » Public Documents

‘ Organize =

Favorite Links Type Size Tags

E| Documents Mo items match your search,
(5 Recently Changed

Bl Desktop

75 Recent Places

& Computer

E Pictures

B‘ Music

More »

Folders -

V|‘f||559r':h

File name:  Exported Test Set]

Save as type: | Test Set package (*.yap)

“ Hide Folders [

Save

) o]

Picture 51 Select File path and name where Test Set is to be exported

Once Export has been finished confirmation message is shown:
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® OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenteri

File Edit Opticns  Window  Help

FH (x MR | Execute Run - £3
Test Set v & Test Set: Mercury Tours Functionality
= E] Teg= _
Bl- E Export Summary u I';'I;] ,-fz[ﬁmj
e

Test set 'Mercury Tours Functionality' exported.

System Fields ",

Test Set Mercury Tours Furgatiomality f

L et apaets. g

Picture 52 Export Confirmation
At this point it is now possible to send this file out to be imported on another OffRoad.

5.10.2 Import

Close Date I ;I ,

When receiving an exported file, select menu File->Import Test Set, select the exported file and click Open.

Import Test Set is also available on Select Test Set form menu.

© OffRoad - Test Set: Mercury Tours Functionality Dorri

File | Edit Options Window Help

Open... Ctrl+0 Execute Run -~ 3
I Save Ctrl+5 Test Set: Mercury
Send Results... Ctrl+R [ServerHttp://qc92:
Clase Chrls L [Download Time: 5,
Description
| Import Test Set... }
Export Test Set... Su.mmar_:,' ;
Create Test Set... :;:.f: ;1,{‘:(;::?-;:
Print Grid
Exit Ctrl+E r
<
System Fields
Close Date

7 ARt N S

Picture 53 Start Importing Test Set from exported file
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) Select Test Sets to Import [

Crganize

L. v Computer » O5(C) » Temp - | 3 | | Search Fe |

Name Date modified Type Size
|| OffRoad.yap || testexporttiyap

Favorite Links

E| Documents

(5 Recently Changed
B Desktop

75 Recent Places
& Computer

E Pictures

B‘ Music

E Searches

Ji Public

Folders ~

File name:  testexportti yap - [Test Set package ("yap) vl

ey (wmerte]

Picture 54 Select Exported Test Set file for import

Once import is done, confirmation message is shown:

r@ OffRoad
File Edit Opticns  Window  Help
e C Execute Run - £9
Test Set ~

Import Summary u

@ 1 Test set(s) imported.

Picture 55 Import Confirmation Message

From this point forward, this imported data can be used for testing or if it contained not uploaded data, this
can be uploaded to Quality Center.
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5.11 Create Test Set
Create Test set is a feature to create another virtual test set from the existing one.

All new runs and defect modifications are still uploaded to the same project and test set which was used to
create this virtual test set.

Note! Runs from source Test Set are not being copied to new virtual test set.

To create new virtual test set, open existing test set and select File->Create Test Set.

) OffRoad - Test Set: Mercury Tours Functionality D::ur,

File | Edit Options Window  Help

| Open... Ctrl+ 0 Execute Run - (
I Save Ctrl+5 Test Sat-
Send Results... Ctrl+R IS hit J

Erver:
Close Ctrl+L [Downloa
Descripti
Import Test Set...
Export Test Set... 5
Create Test Set...

Print Grid
Exit Ctrl+E

Syﬂj}
Close
| m\f."--\“mr\

Picture 56 Create new Virtual Test Set

Select Next to Copy Existing Test Set as a new virtual test set:
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(B Create Test Set

S5

Test Set Creation
Select how to create Test Set

Create Test Set By:

@ Copying Existing Test Set

Finish

%

Picture 57 Select Next to Copy Existing Test Set as a new virtual test set

Note: Above form can show custom selections for creating Virtual Test Set. Verify this with your Quality

Center Administrator.

To start create, select Finish:
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%

(B Create Test Set

S5

Confirmatio
Click Finish to Create Test Set Based an Your selections

Cancel || <<Back

Mext ==

Picture 58 Select Finish to create new virtual test set

Once creating is finished confirmation message is shown:
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® OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

File Edit Options Window

Help

Done

==

e

k-

3

Create Test Set Done, Test Set can be opened from Local Test Set Tree

4

2% Y _

Picture 59 Create New Test Set Confirmation Message

5.12 Managing Local Test Sets
As good practice it is recommended that test sets that are no longer in use are removed from OffRoad.

For this there are two possibilities:

1. Delete Selected Test Set
2. Delete All Test Set

5.12.1 Delete Test Set
Test Set can be deleted when it has been opened from Edit->Delete menu when test set node has been

selected from Local Test Set Tree.

Z H U R | Execute Run ~ @
Test Set « O Test Set: Mercury Tours Functionality f
= E] Test Set (
E|" ;m;]ug—l (# Create Test Set %
o e( |
L[] Attad] ] '
i?? Test Confirmatio - the function
E All P Click Finish to Create Test Set Based on Your selections yerify the N o Tty
= AID -depth verification of
r

)
;
I
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File | Edit | Options  Window

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAUI.T:

Help

rRC Cut cl+X | @ ‘{
Copy Ctrl+C : Mercury T
B- El Paste Ctrl+V http://qcS2- 23080/
=- | Delete Ctrl+D | load Time:5/2
ription
Find Replace E
Select All Ctrl+A ?
Add... F2
Execute Run F3 .
Execute Run (Mini Runner) F4
Execute Run (Maxi Runner) F5
2m Figlds
Grid
" Close Date

-l

Test Set Mercuny

1 h\.

Picture 60 Delete Test Set when Test Set node is selected from Local Test Set Tree

Usually test sets are removed using Select Test Set dialog.

In here mark with checkbox which test sets are to be deleted and select File->Delete. All test sets with
checkbox selected are then deleted and are no longer available
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.
) Select Test Set

File | Options

Open Ctrl+0

Load Test Set From Server... Ctrl+L
Import... Ctrl+I

|| Delete Ctrl+D ||

Delete All Test Sets Ctrl+ A4 ctionality
by

Exit

- of Peformance And Load
vl [£] Mercury Tours Loading
_ .-y [2] Performance Under Load
=[] % Release 105
B[] & Cycle 1
te.[] [2] New Features
-1 & Cycle 2
|:| [£] New Features

Cycle 4
- [] [£] New Features
-.[] [] Regression
toe [ [£] Sanity
----- [ [] testset not to be found

Load...

5 Test set(s) checked

Picture 61 Delete selected local test sets

5.12.2 Delete All Test Sets

Delete all test set takes a step further and deletes all test sets.
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) Select Test Set E@g
File | Options

Open Ctrl+ 0 Load. .
Load Test Set From Server... Ctrl+L
Import... Ctrl+I
|| Delete Ctrl+D
Delete All Test Sets Ctrl+ A4 ctionality
) ity
Exit

B Pedfomance And Loa
-yl [Z] Mercury Tours Loading
: .-y [2] Performance Under Load
=[] % Release 105
-] ¥ Cycle 1
te.[] [2] New Features
B[] & Cycle 2
- [] [£] New Features
.. ][] Regression
- [] ¥ Cycle 3
toe [ 2] Sanity
B[] & Cycle 4
- [] [£] New Features
-.[] [] Regression
toe [ [£] Sanity
----- [ [] testset not to be found

1}

Cancel

5 Test set(s) checked

A A

Picture 62 Delete All local test sets

5.13 Special OffRoad Views

In OffRoad there exist two special views:

1. AllRuns
2. All Defects

There are collections of All Runs executed within this test set and All Defects found on this test set.

These views are read-only views, modifications for items is not possible using these views.

5.13.1 All Runs
When viewing All Runs, it is possible to double click the run row and this will open the selected run and
moves local test set tree focus into this run.
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5.13.2 All Defects
All Defects is similar to All Runs, when double clicking defect row this will move focus to the selected defect
and moves local test set tree focus into this defect.

5.14 Customizing OffRoad User Interface

5.14.1 Selecting Grid Columns
In All grid views it is possible to select which fields to show. This is done using the Select Columns
functionality which is opened either from Edit->Grid->Select Columns menu or from toolbar.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Quality!

File Edit Option Window  Help

= H ' 5 Execute Run ~ (3

Mercuny Tours Fu Status
- @ Defects (75) prmmmmmmms
__ E‘! D P MNoRun [ | Airline Preference[1]
E] w Runs (0) : Mo Run E| Departing And Arriving
E] Al Defects (75) No Run El Departing Date[1]

Mo Run || Returning Date[1]

Mo Run E Wiew Calendar[1]

Mo Run ‘Service Class Preferar
Mo Run ‘Flight Time Preference
Mo Fun : Range of Dates[1]

NoRun || Mumber Of Passenger:
ha Bin [ Trim Tunel11

Picture 63 Open Select Columns

This opens an editor which shows on the left fields which are hidden and on the right fields which are
visible.

Fields can then be moved using the buttons in the middle and column order set using the buttons on the
right.
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Select Columns

Hidden columns:

Description
SA Codes

Visible calumns:

2)[~] [#]v]

Last Run Status
Test Mame

Status On Server
Tester

Exec Date

Time

Planned Host Name
Planned Exec Date
Planned Bxec Time
Responsible Tester
Planned Browser
Planned Language
Creation Date
Execution Status

Designer
Reviewed
Reviewer
Pricrity
Level
EFF Hags
TS_USER_06

Ok

Cancel

) [»]

Picture 64 Select Columns for grid

After selecting Ok grid view is changed to the selected one and next time this same grid is viewed, visible

columns and the order of columns is the one set in here.

5.14.2 Sorting and Filtering in Grids
Grids can be sorted by clicking the column header.

@) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: QualityCenter_Demo

File

G
Test Set

Edit  Options  Window

Help
0l (@ | &5 Execute Run - &

- 3

B E] Test Set
Bl [E] Mercury Tours Functionaliy

H- 38 Defects (75)

=| Attachments .[l}]_.\

E] Al Runs (0)

This shows
sorted column
. and sort order

L‘g{;&:" Test Name [ Status On Server  Tester Exec Date
[~ [+] [+] = [+]
3 |NO Run |+ | Address Options[1] Failed z z 9/14/2005 3:00 AM
Mo Run || Airline Preference[1] Mot Completed [w[ilpo [ ] 5/27/2008 3:00 AM
Mo Run |« | Billing And Delivery Address[1] Passed ™ | 913/2005 2:00 AM
Mo Run |« | Billing And Delivery Address[2] Passed ™ | 9/16/2005 2:00 AM
MoRun || Cancel All Reservations[1] Mot Completed [« ilpo [ | 527/2008 3:00 AM
MoRun || Cancel Checked Reservations[1] Passed ] [ | 9222005 3:00 AM
Mo Run z Change Email (Contact Information : Failed z z %/2/2005 3:00 AM
No Run z Change First & Last Name (Contact : Failed z z 10/24/2005 3:00 A
Mo Run [ | Change Mailing Information[1] Paszed ™ i | 9/7/2005 3:00 AM
MoRun |« | Change Phone (Contact Informatio  Failed ™ i |: 9372005 3:00 AM
Mo Run [« | Confirm Password[1] Passed ™ i |: 91/2005 3:00 AM
Mo Run | |: Credit Card Expiration Date[1] Passed ™ i |: 911/2005 3:00 AM
No Run z Credit Card Number[1] Failed z z 81772005 3:00 AM
Mo Run z Credit Card Owner[1] Failed z z 5/13/2005 3:00 AM
No Run  [= | Nenarting And Arrivinn | aeationsl1] | Mot Comnleted [ =l alex [ R27/2008 300 AM

Picture 65 Sorting in grids is done by clicking column header
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Filtering for row values is done by selecting the filter value in the row below row header.

) OffRoad - Test Set: Mercury Tours Functionality Domain: DEFAULT Project: Qualifuls

File Edit Options Window  Help

= H i (09 | &% Execute Run - &

Test Sat -
Bl E] Test Set

=- E Mercury Tours Functionality
- @ Defects (75)

- [E] Ai Rins {0}

Last Run

Filtered
Column

There are options None, Custom and list of values found in columns.

None will clear the filter.

Selecting value is filtering only rows where this value exists.

Custom opens an Custom Row Filter which has and/or options and operator selections.

s

B Custom Row Filter

S5

Show rows where:
RunTestCase_Actual Tester

does not equal
iz greater than
is greater than or equal to
iz less than
/is less than or equal to
begins with
does not begin with
ends with
,_— does not end with

I

ters

0K

| | cancl

Picture 66 Custom Row Filter

Status Test Name &  Status On Server — Tester
[~ (=] vlilo_ [« .
P NoRun [+] Airline Preference[1] Mot Completed [« [ilpo [ | 527/2008 3:DD'
HoRun |- | Cancel All Reservations[1] Mot Completed [w[ilpo  [= ] 5/27/2008 3:00 Ay
Mo Run [ | Departing Datef1] Mot Completed [w[ilpo [ ] 527/2008 3:w
Mo Run [+ | Returning Date[1] Failed lwlilpo  [=] 5/27/2008 3:
MoRun || View Calendar[1] Failed lwlilpo  [] 5/27/2008 3:1}?

A A
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